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Adobe Photoshop CS3 คืออะไร 
 Adobe Photoshop CS3 เปนโปรแกรมคอมพิวเตอรที่รวบรวมเครื่องมือสําหรับตกแตงภาพประสิทธิภาพสูง 
เพื่อการทํางานระดับมาตรฐานสําหรับนักออกแบบมืออาชพีที่ตองการสรางสรรคงานกราฟกที่โดดเดน ทั้งงานที่ใชบน
เว็บและงานสิ่งพิมพ 
 

ความละเอียดของภาพกราฟก 
    ภาพที่ปรากฏบนหนาจอคอมพิวเตอรนัน้ เกิดจากจุดสี่เหล่ียมเล็กๆ ของสีที่เราเรียกวา พิกเซล (Pixel)  (พิก
เซลเปนองคประกอบที่เล็กทีสุ่ดของภาพ) มาประกอบกันเปนภาพขนาดตางๆ  
  ความละเอียดของภาพจะมีหนวยวัดปน พกิเซล/ตารางนิ้ว และงานกราฟกในแตละแบบก็จะใชความละเอียดที่
แตกตางกัน ดงันี ้

• ภาพที่แสดงบนหนาจอคอมพิวเตอร เชน หนาเว็บ หรืองานพรีเซนเตชัน่ ใชความละเอียด 72 พิกเซล/
ตารางนิ้ว 

• ภาพถายทั่วๆไป ใชความละเอียด 150 พิกเซล/ตารางนิ้ว 

• ภาพในงานพิมพ ใชความละเอียด  300 พิกเซล/ตารางนิ้ว 
 

พื้นที่การทํางาน (Work Area) 
 Work Area หรือพืน้ที่การทํางานของโปรแกรม Adobe Photoshop จะประกอบดวยเครือ่งมือสําหรับการ
ตกแตงไฟลภาพตาง ๆ ดังนี้  

1. Menu bar คือสวนที่แสดงชื่อเมนูตางๆ ของโปรแกรม ก็จะประกอบดวย 
 File , Edit , Image , Layer , Select  ,  Filter , View  , Window  , Help   

  1.1 File หมายถึง คําสั่งเกี่ยวกับการจัดเก็บและเรียกใชไฟลรูปภาพตางๆ  
  1.2 Edit หมายถึง คําสั่งเกี่ยวกับการแกไขลักษณะของรปูภาพและ Image ตางๆ  
  1.3 Image หมายถึง คําสั่งการจัดการรูปภาพและ Image ตางเชน การเปลี่ยนสีและการ   
        เปลี่ยนขนาด  
  1.4 Layer หมายถึง ชั้นหรือลําดับของรูปภาพและวัตถุที่เราตองการจะทํา Effects  
  1.5 Select  เปนคําสั่งการเลือกพื้นที่หรือสวนตางของรูปภาพและวัตถุในการที่จะเลน Effects  
         ตางๆ  
  1.6 Filter เปนคําสั่งการเลน Effects ตางๆสําหรับรูปภาพและวัตถุ  
  1.7 View เปนคําสั่งเกี่ยวกับมุมมองของภาพและวัตถุในลกัษณะตางๆ เชน การขยายภาพ 
         และยอภาพใหดูเล็ก  
  1.8 Window  เปนสวนคําสั่งในการเลือกใชอปุกรณเสริมตางๆที่จําเปนในการใชสราง Effects  
         ตางๆ  
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  1.9 Help เปนคําสั่งเพื่อแนะนําเกี่ยวกับการใชโปรแกรมฯและจะมีลายละเอียดของโปรแกรม  
        อยูในนัน้ 

2. Toolbox คือสวนของอุปกรณตาง ๆ ที่ใชในการสรางชิ้นงานหรือตกแตงภาพ 
3. Tool options bar คือสวนที่กําหนดคุณสมบัติของอุปกรณที่เลือกจาก Toolbox 
4. Palettes คือสวนที่ใชตรวจสอบและกําหนดคุณสมบัติตาง ๆ ใหกับรูปภาพ 
5. Status bar คือสวนที่แสดงรายละเอียดตาง ๆ ของชิ้นงาน เชน ขนาดของมุมมองรูปภาพ ขนาดของไฟล 

คําแนะนําการใชงานของอุปกรณที่เลือกจาก Toolbox 
 

Tool options bar 

Work area 

Menu bar 

Toolbox 

Palettes 
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เคร่ืองมือตางๆ (Toolbox) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
หมายเหตุ ปุม Toolbar ที่มีเครื่องหมายสามเหลี่ยมเล็กๆ อยูดานลางขวาเมื่อกดปุมสามเหลี่ยมดังกลาว โปรแกรมจะ

แสดงเครื่องมืออื่นๆ ออกมาเชน   
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อธิบาย Tool ตางๆ 

 
Marquee Tool
เปนการเลือกแบบสี่เหลี่ยมผืนผา, วงกลม, แถวขนาด 1 พกิเซลส หรือคอลัมน 1 พิกเซลส  

 
Move Tool  
ใชเพื่อเลื่อนสวนที่เลือก หรอืไวเล่ือน Layer และ Guide ตางๆ 

 

Lasso Tool
จะใชเพื่อสราง Selection แบบอิสระ, แบบ Polygonal (ตามจุดที่คลิก) และ Magnetic (ดึงเขาหาขอบ
รูปภาพ) 

 
Magic Wand Tool  
ใชเลือกพื้นที่บริเวณที่มีสีเดียวกัน 

 
Crop Tool  
ใชในการเลือกบางสวนของรปูภาพ 

 
Slice Tool
ใชในการสราง Slice 

 
Slice Selection Tool
ใชเลือก Slice ที่คุณสรางขึ้นมา 

 
Healing Brush Tool 
ใชในการระบายสี เพื่อซอมแซมรูปภาพใหสมบูรณแบบ 

 

Patch Tool 
ใชเฉพาะในบรเิวณที่เลือกไวเทานั้น เพือ่ใหเกิดความสมบูรณของรูปภาพ โดยใชลวดลาย หรือใชสวนที่เลือก
ในภาพเปนตนฉบับ 

 
Brush Tool  
ใชในการวาดเสน Brush ตางๆ 

 
Pencil Tool  
ใชในการวาดเสนที่มีขอบชัดเจน 

 
Clone Stamp Tool 
ใชก็อปปรูปโดยอาศัยรูปภาพตนฉบับ 

 
Pattern Stamp Tool  
ใชเพื่อวาดรูปโดยใชบางสวนของรูปภาพที่มอียูเปนตนฉบบั 

 
History Brush Tool   
ใชกลับคืนรูปภาพเดิมจาก State หรือ Snapshot ของรูปเดียวกัน 

 

Art History Brush Tool 
ใชในการวาดรูป จาก State หรือ Snapshot ของรูปนี้โดยอาศัยรูปแบบของ Stoke ที่มีสไตลหลากหลาย ชวย
ใหสไตล ของภาพดูตางออกไป 
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Eraser Tool  
ใชลบรูปภาพหรือลบบางสวนของพิกเซลสและทําการเก็บสวนตางๆ เปน State ตางๆ ใน History Palette 

 
Magic Eraser Tool  
ใชลบรูปภาพบริเวณที่มีสีเดียวกันใหกลายเปนพื้นทีโ่ปรงใส (Transparent) โดยการคลกิเพียงครัง้เดียว 

 
Background Eraser Tool 
ใชลบรูปภาพบางสวนใหกลายเปนพื้นทีโ่ปรงใสโดยการลากเมาส 

 
Gradient Tools 
ใชเพื่อไลสีระหวางสีหลายๆ สี ในแบบตางๆ Straight-line,  Radial, Angle, Reflected และ Diamond 

 
Paint Bucket Tool  
ใชในการเติมสี Fill ในบริเวณที่เปนสีเดียวกันดวยสีของ Foreground 

 
Burn Tool  
ใชลดความสวางทําใหรูปภาพดูมืดลง

 
Sponge Tool  
ใชเปลี่ยนสีในสวนตางๆ ของรูปภาพ โดยการปรับคาความเขมสี

 
Path Selection Tool
ใชเพื่อเลือก Shape หรือ Path เพื่อแสดง Anchor Paint, Direction Line และ Direction Paint  

 
Type Tool  
ใชในการสรางตัวหนังสือลงบนรูปภาพ 

 
Type Mask Tool 
ใชสราง Selection เปนรูปรางตัวหนังสือ 

 
Pen Tools
ใชในการลากเสน Path ซึ่งสามารถดัดโคงตามรูปภาพได 

 
Custom Shape Tool
ใชเลือกรูปภาพเลือกรูปภาพที่มีรูปรางเฉพาะจาก Custom Shape List 

 
Animations Tool
ใชเขียนโนต หรือแนบเสียงไปกับรูปภาพได 

 
Eyedropper Tool  
ใชในการดูดสีจากรูปภาพเพื่อใชเปนตนแบบของสีกับงานชิน้อื่นๆ 

 
Measure Tool
ใชวัดระยะหาง, ตําแหนงและมุมองศาระหวางภาพ 

 
Hand Tool  
ใชเล่ือนภาพที่อยูในหนาตางเดียวกัน 

 
Zoom Tool  
ใชในการขยายและยอสวนการแสดงภาพบนหนาจอ 
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การเปดไฟลภาพ (Open) 
 

1. คลิกที่เมนูคําสั่ง File ที่แถบ Menu bar จากนั้นเลือกคําสั่ง Open 

 
 

2. จะปรากฏ Dialog แสดงรายชือ่ไฟลตาง ๆ ดังภาพ เพื่อเลือกไฟลที่ตองการเปดมาใชงาน 

 
 

3. คลิกเลือกไฟลที่ตองการเปดใชงาน จากนัน้คลิกปุม Open 
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การสรางไฟลใหม (New) 
 

1. คลิกที่เมนูคําสั่ง File ที่แถบ Menu bar จากนั้นเลือกคําสั่ง New 
 

 
 

2. จะปรากฏ Dialog สําหรับกําหนดคุณสมบัติตาง ๆ ของไฟลภาพดังนี้ 
 

 
 

- Name คือ ชือ่ของชิน้งาน สามารถกําหนดใหมเองได ชื่อนีจ้ะไประบุที่ชื่อไฟลตอไป 
- Preset คือ ขนาดงานที่โปรแกรมกําหนดมาให ซึ่งมหีลากหลายขนาดใหเลือก หรือสามารถ

กําหนดเองจากชอง Width และ Height ได 
- Width คือ ขนาดความกวางของงาน (จากซายไปขวา) โดยกําหนดหนวยและขนาดไดเอง 

จากรูป คือ 1024 Pixels 
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- Height คือ ขนาดความกวางของงาน (จากบนลงลาง) โดยกําหนดหนวยและขนาดไดเอง 
จากรูป คือ 768 Pixels 

- Resolution คือ ความละเอียดของภาพ โดยใสตัวเลขคาความละเอียดของภาพ เชน งาน
เว็บหรือรูปที่แสดงบนคอมพวิเตอรเทากับ 72 pixels/inch งานสิ่งพิมพเทากับ 150-200 pixels/inch 

- Color Mode คือ โหมดสีของภาพ ซึ่งประกอบไปดวย โหมดสี Bitmap, Grayscale,  
RGB Color, CMYK Color, Lab Color  

- Background Contents คือ สีพื้นหลังของภาพ เม่ือเริ่มชิน้งานใหม มีดังนี ้

• White กําหนดใหสีพื้นหลงัเปนสีขาว 

• Background Color กําหนดใหสีพื้นหลงัเปนสีเดียวกับ Background 

• Transparent ไมมีพื้นหลัง 
 

3. หลังจากกําหนดคุณสมบัติตาง ๆ ใหคลิกปุม OK เพื่อเริ่มชิน้งานใหม 
 

การบันทึกขอมูลลงบนไฟล (Save) 
 

 หลังจากตกแตงไฟลภาพเรียบรอย จะตองเก็บบันทึกขอมลูลงบนไฟล (Save) สําหรับการเรียกใชงานในครัง้
ตอไป โปรแกรมมีการบันทึกขอมูลลงบนไฟล (Save) อยู 3 ลักษณะ คือ  

- Save บันทึกไฟลในรูปแบบ (Format) ปกติ ซึ่งจะอยูในรูปแบบ (Format) ของ PSD 
- Save As บันทึกไฟลในรูปแบบ (Format) อื่น ๆ ได เชน JPEG, BMP, GIF เปนตน 
- Save for Web บันทึกไฟลในรูปแบบ (Format) สําหรับการใชงานบนเว็บ เชน ไฟล 

Html และไฟลรูปภาพ JPEG, GIF, PGN เปนตน 
ในที่นี่เปนแสดงการใชงานของ Save และ Save As 

1. คลิกที่เมนูคําสั่ง File ที่แถบ Menu bar จากนั้นเลือกคําสั่ง Save หรอื Save As  หรือ Save for 
Web & Devices 
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2. จะปรากฏ Dialog สําหรับกําหนดคุณสมบัติตาง ๆ ของไฟลภาพดังนี้ 
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- ชื่อไฟล (File Name) 
- รูปแบบของไฟล (Format) 
- กําหนดคุณสมบัติของการบันทึกไฟล (Save Options) 

• As a Copy บันทึกไฟลเปนชือ่อื่น รูปแบบ (Format) อื่น ขณะที่ไฟลเดิมกําลังเปดใช
งาน 

• Layers จะเก็บคุณสมบัติของ Layer ตาง ๆ  

• Use Proof setup เก็บคาโหมดสีที่จะใชแสดงสีของภาพกอนจะพิมพ 

• Thumbnail กําหนดใหไฟลทีบ่ันทึก (Save) สามารถแสดงภาพตัวอยางใน Dialog ของ
การเปดไฟล 

• Use Lower Case Extension กําหนดใหนามสกุลไฟลเปนอักษรตัวเล็ก 
3. หลังจากกําหนดคุณสมบัติตาง ๆ ใหคลิกปุม Save เพื่อบันทึกขอมูลลงบนไฟล 

 

การใชงาน Palettes 
 

 Palettes คือ Dialog ที่ใชตรวจสอบและกําหนดคุณสมบัติตาง ๆ ของรูปภาพ เชน Palette ของ Navigator 
และ Info, Palette ของ Color, Swatches เปนตน  

Palette ตาง ๆ จะถูกจัดเปนกลุม ๆ สําหรบัการซอนหรอืแสดง Palettes นั้นใหคลิกที่เมนูคําสั่ง Window 
จากนั้นเลือก Palette ที่ตองการซอนหรอืแสดง Palette ใดถูกเปดใชงานอยูจะมีเครือ่งหมายถูก 
หนา Palette  
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Navigator Palette 
 Navigator Palette เปน Palette ที่ใชสําหรับเปล่ียนขนาดมุมมอง ที่จอภาพตามความเหมาะสม 

ประกอบดวยสวนตาง ๆ ดังนี ้
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Zoom Slider 

Zoom In Zoom Out  

ตัวเลขเปอรเซ็นตของภาพ 

Proxy Preview 
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1. Proxy Preview Area คือสวนที่แสดงถงึขนาดของภาพในชิ้นงาน กรอบสีหมายถึงขนาดของชิ้นงาน หาก

กรอบของ Proxy Preview อยูริมสุดของภาพแสดงวาภาพนั้นมีขนาดพอดีกับชิ้นงาน 
2. ตัวเลขเปอรเซน็ตของภาพ คอืสวนที่ใชกําหนดขนาดมุมมองของภาพ ซึง่อยูในรูปแบบของเปอรเซ็นต 

โดยคาของขนาดภาพจริงจะเทากับ 100 เปอรเซน็ต 
3. Zoom Out & Zoom In คือสวนที่ใชกําหนดขนาดมุมมองของภาพ ประกอบดวยสวนที่ใชกําหนด 3 สวน 

คือ 
3.1 Zoom Out คือสวนที่อยูดานซายสุด ใชสําหรับยอขนาดมุมมองของภาพใหเล็กลง 
3.2 Zoom In คือสวนที่อยูดานซายสุด ใชสําหรับขยายขนาดมุมมองของภาพใหใหญขึ้น 
3.3 Zoom Slider คือสวนที่เปนแถบเลื่อน หากเลื่อนทางดานซายจะยอขนาดมุมมองของภาพใหเล็กลง 

แตหากเลื่อนมาทางขวาจะขยายขนาดมุมมองของภาพใหใหญขึน้ 
 
Color Palette 
 Color Palette คือ Palette ที่ทําหนาที่เปนจานสี ซึ่ง Mode สีที่ปรากฏในภาพจะเปนลักษณะการผสม
ใน Mode RGB มีสวนประกอบตาง ๆ ดังนี ้

1. Set foreground color คือสวนแสดงสีของ foreground 
2. Set background color คือสวนแสดงสีของ background 
3. RGB slider คือสวนที่ใชกําหนดคาของการผสมสีใน Mode RGB ซึ่งสามารถเลื่อนเพื่อปรับคาสี

ไดจากแถบ slide หรือระบุเปนตัวเลข (0-255) เชน สีดํา คอื R=0,G=0, B=0 
4. Sample color คือสวนสําหรับกําหนดคาสีในลักษณะจุมเลือกสี 
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 Sample color 

RGB slider Set background color 
Set foreground color 

Swatches Palette 
  Swatches Palette คือ Palette ที่ทําหนาที่สําหรับเก็บสีหลกัๆ ที่นิยมใช สามารถเลือกนํามาใชได
ทันทีและถาหากวาคุณมีสีที่ตองการใชเปนประจํา สามารถบันทึกสีนั้นไวใน Palette นี้ได  

การบันทึกสีที่ตองการไวที่ Swatches Palette สามารถทําไดโดยเลือกสีที่ตองการ จากนั้นคลิกเมาสที่
ปุมบันทึกสีใหมที่ Swatches Palette จะสามารถบันทึกสทีี่ตองการได 
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ลบสีที่มีอยู 

บันทึกสีใหม 

สีหลักๆ ที่ใชเปนประจํา 

 
Styles Palette 
  Styles Palette คือ Palette ที่มีไวสําหรับเก็บลวดลายอยางลวดเร็ว สามารถเลือกลวดลายจาก 
Palette นี้ไปใชในภาพ จะทําใหภาพที่คุณวาดไวเปลี่ยนไปตามลวดลายที่เลือกไวทันท ีและยังสามารถสราง
ลวดลายใหขึ้นมาเองไดดวย 

การใชงานนั้นสามารถทําไดโดยเลือกที่ Layer ที่ตองการจะทํา Style แลวคลิกเลือกที่ Style บน 
Styles Palette จากนั้น Layer จะเปลี่ยนตาม Style นั้นๆ 
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ลวดลายตางๆ 

Clear Style 

New Style 

Delete Style 
 
History Palette 
 
   เปน Palette ที่แสดงขั้นตอนวิธีการตาง ๆ ทีใ่ชทํางานกับไฟลภาพตามลําดับโดยสามารถยอนกลับ
ไปยังการทํางานตาง ๆ ในลําดับชั้นและยกเลิกได ประกอบดวยสวนตาง ๆ ดังนี ้

 1. สวนที่ใชกําหนดขอมูลของการใช History Brush Tool 
 2. เปนภาพที่แสดงรายละเอียดของงานที่ทําตามลําดับ 
 3. History State เปนลําดับขั้นตอนวิธีการตาง ๆ ที่ไดกระทําลงไป 
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 4. New Document คือสวนที่ใชสรางกระดาษทําการใหม โดยคัดลอกภาพจากลําดับที่ชี้อยู 
 5. New Snapshot คือสวนทีใ่ชสราง Snapshot ใหม 
 6. Trash Button คือสวนที่ใชลบขั้นตอนการทํางานกับไฟลภาพในลําดับที่เลือกอยูออก 
 
 

 
 1 2  
 

3 
 
 
 
 4 5 6 
Layer Palette 

 Layer Palette เปน Palette ที่เก็บชิ้นงานหรือภาพทั้งหมด เรียกวา Layer ซึ่งจะเรียงลาํดับกอนหลัง 
ทําใหเกิดความสะดวกในการจัดการแกไขโดยไมเกิดผลกระทบกับชิ้นงานหรือภาพอื่น ๆ โดยจะแกไขเฉพาะ
ชิ้นงานหรือภาพใน Layer ที่เลือกเทานั้น สวนประกอบของ Layer Palette มีดังนี้ 
1. Indicates Layer Visibility  คอืสวนที่กําหนดการแสดงผลของ Layer หากมีสัญลักษณรูปตาแสดงวาภาพ

ที่อยูใน Layer ดังกลาวถูกแสดงบน Work Area หากไมมีแสดงวา Layer นั้นถูกซอนหรอืไมแสดงผล 
2. Indicates if Layer is Linked คือสวนที่แสดงวา Layer ใดกําลังถูกทํางาน Layer นั้น จะมีสัญลักษณรูป

พูกัน นอกจากนี้ยังสามารถกาํหนดให Layer อื่นเลื่อนตําแหนงตาม Layer ที่กําลังทํางานอยูไดโดยการ
คลิกให Layer อื่นเปลี่ยนเปนสัญลักษณรูปโซ 

3. Add a Layer Style คือสวนที่ใชใส Effect เชน แสง เงา ตาง ๆ ใหกับภาพใน Layer 
4. Add a mask คือสวนที่ใชเพิม่ Mask หรอืเพิ่ม 1 Layer ซอนทับ Layer ที่กําลังทํางานอยู โดยทั้ง 2 จะถือ

เปน Layer เดียวกัน 
5. Create a new set คือสวนที่ใชสราง Folder สําหรับเก็บ Layer ตาง ๆ เขาดวยกัน 
6. Create new fill or adjustment layer คือสวนที่ใชปรับคาสี ความคมชัด แสงและความสวางในแบบตาง ๆ 

ของภาพใน Layer 
7. Create a new layer คือสวนที่ใชสราง Layer ใหม 
8. Delete layer คือสวนที่ใชลบ Layer 
9. Layer Thumbnail คือสวนที่แสดงวา Layer นั้นมีภาพใดอยู 
10. Lock คือสวนทีใ่ช Lock ในรูปแบบตางๆ 
11. Opacity คือสวนที่ใชทําให Layer นั้นโปรงใส  (ทั้ง Fill และ Effect) 
12. Fill คือสวนที่ใชทําให เฉพาะ Fill ใน Layer นั้นโปรงใส ซึ่งไมรวม Effect ที่ Layer นั้นมอียู 
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หมายเหตุ:  แถบสีน้ําเงินแสดงวากําลังทํางานกับ Layer 2  

การจัดลําดับ Layer สามารถทําไดโดยนําเมาสคลิกคางไวที่ Layer แลวลากไปยังตําแหนง
ที่ตองการ หรือใชเมนูคําสั่ง Layer -> Arrange 

• Bring to Front คือ สง Layer ไปยังตําแหนงบนสุดของทกุ Layer 

• Bring Forward คือ สง Layer ขึ้นไปตําแหนงบน 1 ขั้น 

• Send Backward คือ สง Layer ลงไปตําแหนงลาง 1 ขั้น 

• Send to Back คือ สง Layer ลงไปตําแหนงลางสุดของทุก Layer แตยกเวน 
Background Layer 

 

การกําหนดพื้นที่ เพื่อแกไขและตกแตงภาพ (Selection) 
 

Marquee Tool เปนเครื่องมือสําหรับการกําหนด Selection โดยคลิกเลือก Marquee Tool จาก Tool box จะมี
ใหเลือกใชงาน 4 รูปแบบตามความเหมาะสม

 Rectangular Marquee Tool  
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สําหรับการสราง Selectionเปนสี่เหลี่ยมผืนผา และสี่เหล่ียมจัตุรัส

 Elliptical Marquee Tool  
สําหรับการสราง Selection เปนวงกลมและวงรี

 Single Marquee Tool  
สําหรับการสราง Selection เปนพื้นทีรู่ปเสนตรงในแนวนอน ความกวาง 
1 pixel 

 Single Column Marquee Tool  
สําหรับการสราง Selection เปนพื้นทีรู่ปเสนตรงในแนวตัง้ ความกวาง  
1 pixel  
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วิธีการใชงาน Marquee Tool 
 
1. ใหคลิกที่ Marquee Tool บน Tool Box หรือหากตองการเลือกรูปแบบอื่นของ Marquee Tool ให

คลิกเมาสคางไว แลวคลิกเลือกรูปแบบที่ตองการสราง Selection 
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2. วางตําแหน ของ Cursor  รูป เพื่อกําหนดจุดเริ่มสําหรับการสราง Selection 
3. ใหคลิกเมาสคางไวและลากเพื่อกําหนดขนาดของพื้นที่ทีต่องการ แลวปลอยเมาส จะปรากฏเสนประ

ของ Selection ดังภาพ 

               
 
Marquee options 

เม่ือคลิกเลือกใชงาน Marquee Tool ที่ Tool options bar เราจะสามารถกําหนดคุณสมบัติตาง ๆ ของ 
Marquee tool ไดดังนี ้

 
 
 

Width Height Style การแกไข Selection 

Feather 

 
1. การแกไข Selection จะมีใหเลือก 4 รูปแบบคือการกําหนดเลือก Selection ใหม การเพิม่ ตัดและลด 

Selection และการสราง Selection ดวยวิธีการตางๆ ดังนี ้
เม่ือคลิกเมาสจะเปนการสราง Selection ขึ้นใหม 
สราง Selection เพิ่มขึ้น โดยพื้นที่ Selection กอนหนาจะไมหายไป แตจะถูกรวมเขาดวยกัน 
ลบพื้นที่ของ Selection ออกจาก Selection กอนหนา 
เปนการสราง Selection ใหมในพื้นที ่Selection เดิม ดวยวิธี Intersect จากพื้นที่ Selection ที่กําหนด
ใหมและ Selection กอนหนา ที่มีพื้นที่เดียวกัน 

2. Feather กําหนดความฟุงเบลอของขอบ Selection ภาพ มีคาตั้งแต 1 – 250 หากกําหนดคามากความฟุง
เบลอจะมากตาม 

3. Style ของ Marquee Options มี 3 รูปแบบคือ 
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• Normal เลือกขนาดอิสระ ขนาดของ Selection จะเปลี่ยนไปตามการเคลื่อนตําแหนงเมาส 

• Constrained Aspect Ratio  กําหนดขนาดของ Selection โดยยืดหยุนตามอัตราสวนของความ
กวาง (Width) และความสูง (Height) 

• Fixed Size กําหนดขนาดของ Selection ตามอัตราสวนของความกวาง (Width) และความสูง 
(Height) ที่แนนอน       

4. Width การกําหนดความกวางของ Selection 
5. Height การกําหนดความสูงของ Selection 

 

การสราง Fixed Size Selection  
 
ถาตองการสราง Selection ขนาดกวาง 600 ยาว  80 Pixels ใหเปลี่ยนชอง Style เปนแบบ Fixed 

Size และกําหนดความกวางและความยาวตามที่ตองการ  
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                                                                                 เปลี่ยนเปน Fixed Size           ระบุขนาด กวาง 

และยาว 

Lasso Tool 
  
เปนเครื่องมือที่สามารถสราง Selection ไดอยางอิสระ มีความยืดหยุนสูง เม่ือคลิก Lasso Tool ที่ 

Tool bar จะมีใหเลือกทั้งหมด 3 รูปแบบดังนี ้
1. Lasso Tool 

  เปนการสราง Selection อยางอิสระ วิธีการใชงานเมื่อคลกิเมาสคางแลวลากไปตามขอบของพืน้ที่ 
Selection ที่ตองการ จนมาบรรจบที่จุดเริ่มตนแลวจึงปลอยเมาสจะปรากฏเสนประของ Selection สามารถ
กําหนดคุณสมบัติของ Lasso Tool ตาง ๆ ไดดังนี้ 
 
 

1 2 
 

 

• Feather กําหนดความฟุงเบลอของขอบพืน้ที่ Selection 

• Anti-aliased กําหนดใหขอบของพืน้ที่ที่เลือกมีความเรียบยิ่งขึ้น ไมขรุขระ 
 

2. Polygonal Lasso Tool 
 เปนการสรางพืน้ที่ของ Selection ในลักษณะของรูปหลายเหล่ียม คลิกเมาสบนภาพเพื่อกําหนด
จุดเริ่มตนในครั้งแรกแลว ลากเมาสจะปรากฏเสนตอจากจุดเริ่มตนกับปลายเมาส วิธีการใชงานเมื่อคลกิเมาส
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Selection ที่เปนเสนตรงเชื่อมจากจุดตนมายังจุดปลายเมาสที่คลิก ใหทําแบบนี้เรื่อย 
ๆ เพื่อสรางเสนขอบของ Selection จนสุดทายใหคลิกเมาสบรรจบที่จุดเริ่มตนครั้งแรก จะเกิด Selection ขึ้น 
สําหรับการกําหนดคุณสมบัติจะเหมือนกับ Lasso Tool 
 

3. Magnetic Lasso Tool 
เปนการสรางพื้นที่ของ Selection อยางอสิระและรวดเรว็ในลักษณะของแมเหล็กที่ดูดเขาหาสี โดย 

Magnetic Lasso Tool จะใชความแตกตางระหวางสีที่เลือกกับสีของ Background เปนตัวกําหนดขอบเขต
พื้นที่ Selection วิธีการใชงานเมื่อคลิกเมาสเพื่อกําหนดจดุเริ่มตนแลว ใหปลอยเมาสแลวลากเมาสตาม
ขอบเขตพื้นทีท่ี่ตองการเลือก Magnetic Lasso Tool จะเลือกขอบเขตพืน้ที่ Selection เองโดยอัตโนมัติ จน
สุดทายใหคลิกเมาสบรรจบที่จุดเริ่มตนครัง้แรก จะเกิด Selection ขึ้น คณุสมบัติของ Magnetic Lasso Tool 
มีเพิ่มจาก Lasso Tool ไดดังนี ้

 

 
 

1 2 3  
1. Width มีคาตั้งแต 1-40 pixels เปนการกําหนดใหโปรแกรมทําการตรวจสอบหาขอบเขตของพื้นที่ที่เลือก 

นับต้ังแตจุดที่เมาสชี้อยูไป X pixels เพื่อกําหนดขอบเขต 
2. Edge Contrast มีคาตั้งแต 0-100% หากมีคามากจะทําใหเสนขอบของพื้นที่ที่เลือกอยูระหวางสีที่

Contrast กันมาก 
3. Frequency มคีาตั้งแต 0-100 pixels หากคาความถี่มากจะทําใหมีการกําหนดจุดในแตละชวงของการ

เลือกมาก ทําใหโปรแกรมสามารถเลือกพืน้ที่อยางมีความถูกตองมากขึ้น 
 

Magic Wand Tool 
 

 กําหนดพื้นที่ของ Selection โดยเลือกบริเวณที่มีคาสีใกลเคียงกัน วิธีการใชงานคือคลิกที่ปุม  
บน Tool box แลวคลิกเลือกพื้นที่ที่ตองการสราง Selection นอกจากนี้แลวยังสามารถกําหนดคุณสมบัติของ 
Magic Wand Tool ไดดังนี ้

 
 

1 2 3 4 

 
 

 
1. Tolerance มีคาใหกําหนดตั้งแต 0 – 255 pixels เปนคาของจํานวนสีที่ใกลเคียงกับสีที่ถูกเลือก 
2. Anti-aliased กําหนดใหขอบของพื้นที่ที่เลือกมีความเรียบยิ่งขึ้น ไมขรุขระ 
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3. Contiguous สามารถทําการเลือกบริเวณสีที่ใกลเคียงกันไดเฉพาะในกลุม pixels ที่ไดคลิกเลือกเทานั้น ถา
ไมได Check ไวจะเลือกบริเวณที่มีสีใกลเคียงกันในภาพทัง้หมด 

4. Use All Layers เลือกสีโดยมองทุก Layer เปนเหมือน Layer เดียว หากไมถูก Check ไว หมายถึงใช 
Magic Wand Tool เฉพาะ Layer นั้นเทานัน้ 

 

Crop Tool 
 

กําหนดพื้นที่ของ Selection โดยตัดสวนที่เหลือที่ไมไดอยูในพื้นที่ของ Selection 

 
Training Service (ICT Center) 

ในภาพทิ้งไป 
วิธีการใชงานคือคลิกที่ปุม           บน Tool box แลวคลิกเมาสคางไวจากนั้นลากเมาสเพื่อกําหนดพืน้ที่ของ 
Selection แลวจึงปลอยเมาส เม่ือพรอมที่จะตัดสวนที่เหลือออก ใหคลิก ปุม           บน Tool 
options bar   หรือ ปุม เพื่อยกเลิก นอกจากนี้เรายังสามารถกําหนดคุณสมบัติตาง ๆ ของการตัด
ดังนี ้

 
 
 
 

1. Cropped Area เลือกผลลพัธของภาพที่ตัด 
1 2 4 5 3 

• Delete ตัดภาพโดยลบสวนที่เหลือออก 

• Hide ตัดภาพ โดยซอนสวนทีเ่หลือเอาไว 
2. Shield cropped area แสดงสีบนพื้นที่สวนทีเ่หลือที่จะถูกตดัออก 
3. Color สีที่จะแสดงบนพื้นที่สวนที่เหลือ 
4. Opacity คาความโปรงแสงของสีบนพื้นที่สวนที่เหลือ 
5. Perspective ปรับพื้นที่การตัดใหไดภาพที่มีมิติ 

 

คําสั่งพืน้ฐานของ Selection 
 

• All กําหนดพืน้ที่ Selection โดยใชพื้นที่ของรูปภาพทั้งหมด 

• Deselect ยกเลิกการกําหนดพื้นที่ Selection 

• Reselect ยอนกลับไปกําหนดพื้นที ่Selection หลังจากไดยกเลิกไป 

• Inverse เปนการเปลี่ยนพื้นทีข่อง Selection จากที่กําหนดไวใหเปน
พื้นที่ตรงขาม 
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การใช Transform เพือ่ปรับเปลี่ยนพื้นที่ Selection  
 

คลิกที่เมนูคําสั่ง Edit ที่แถบ Menu bar จากนั้นเลือกคําสั่ง Transform 
- Again กลับสูรปูแบบเดิมกอนหนานี ้1 ขั้น 
- Scale ปรับเปลี่ยนแบบ Scale ตามแนวตั้ง แนวนอนและแนวทแยง 
- Rotate หมุนพื้นที่ที่เลือก 
- Skew ปดเกลียวพื้นที่เลือก 
- Distort การบิดเบือนพื้นที่เลือก 
- Perspective ปรับขนาดของพื้นที่เลือกใหมลีักษณะการมองแบบ Perspective 

(แบบมีมิติ ความกวาง ความยาว ความลึก) 
- Rotate 180? CW หมุน 180 องศา 
- Rotate 90? CW หมุน 90 องศาตามเข็มนาฬิกา 
- Rotate 90? CCW หมุน 90 องศาทวนเข็มนาฬิกา 
- Flip Horizontal กลับจากซายเปนขวา 
- Flip Vertical กลับจากบนลงลาง 

 

การใชงาน Foreground และ Background Color 
 
การใชงานในสวนของ Foreground และ Background Color สามารถทําไดที่สวนของ Toolbox ดังรูป 
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Foreground 

Background 

Switch Color 

Default 

สามารถเปลี่ยนสีไดโดยคลิกที่กรอบ Foreground  หรือ Background จะปรากฏ Color Picker ใหเปลี่ยนสี 
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การใชงาน Type Tool 
 

        สามารถสรางขอความไดทั้งในแนวนอนและแนวตั้ง         การสรางขอความแตละครั้งโปรแกรม Adobe 
Photoshop จะสราง Layer ใหมอัตโนมัติ ลกัษณะของขอความจะมี 2 รปูแบบคือ 
 

1. แบบ Point Type จะมีรูปแบบเปนคําหรืออักษรสั้น ๆ 1 บรรทัด โดยกําหนดจุดเริ่มตนของขอความบน
ชิ้นงาน โปรแกรมจะสราง Type Layer ขึ้นมา และสามารถพิมพขอความลงไปได  
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เม่ือพิมพขอความ
เรียบรอย ใหคลิกที่ปุม          เพื่อตกลง หรือคลิกปุม   

2. แบบ Paragraph Type จะมีรูปแบบเปนขอความที่มีหลายบรรทัด โดยจะอยูภายในขอบเขตที่กําหนด
เดียวกัน (Bounding box) โดยกําหนดจุดขอบเขตของขอความที่ใส โปรแกรมจะสราง Type Layer ขึ้นมา 
และสามารถพิมพขอความและจัดเปน Paragraph ไดจาก Paragraph Palette เม่ือพิมพขอความ
เรียบรอย ใหคลิกที่ปุม          เพือ่ตกลง หรือคลิกปุม  

 
  

ขอความในแนวนอน
ขอความในแนวตั้ง 
ขอความ Selection ในแนวนอน 
ขอความ Selection ในแนวตั้ง 

 
 
 
 
 

 
หากตองการแกไขขอความทีพ่ิมพใหคลิกทีปุ่ม      แลวลากเมาสบนขอความที่ตองการแกไขใหเกิดแถบสี แลว

จึงปรับแกไขขอความ หรอืเปลี่ยนแปลงคุณสมบัติตาง ๆ ของขอความบน Tool options bar เม่ือแกไขเรียบรอยแลวจึง
คลิกปุม  

หากตองการตัวอักษรที่มีลวดลายของภาพ Background เชน                                                    
สามารถทําไดโดยใชสราง Selection ของตัวอักษร ซึ่งมีวิธีใหคลิกที่ปุม        เพือ่เลือก Horizontal Type Mask Tool 
หรือ Vertical Type Mask Tool แลวพิมพขอความที่ชิ้นงาน เม่ือพิมพเสร็จ จะเกิด Selection ที่เปนตัวอักษร จากนัน้
สามารถที่จะคัดลอกลวดลายภาพที่ตองการตาม Selection ของขอความนั้นได 
 
คุณสมบัติตาง ๆ ของ Type Tool 

ชนิดของตัวอักษร ขนาดตัวอักษร การวางตําแหนง

ของขอความ 

รูปแบบตัวอักษร 

ตกแตงขอบ

ตัวอักษร สีตัวอักษร 

Warp Text 

การกําหนดรูป 

แบบตัวอักษร  
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 Warp Text เม่ือคลิกปุม        จะปรากฏ Dialog สําหรับกําหนดคาเพื่อปรับแตงรูปทรงของขอความ 
 

 
 
ตัวอยาง Warp Text 

 
 

การใชงาน Layer 
 

ลักษณะการทํางานของ Layer เปนเหมือนแผนใสวางซอนกันเปนลําดับของรูปภาพ ชวยแยกการทํางานให
ชัดเจน โดยการทํางานแตละครั้งจะมีผลกับ Layer ที่เลือกอยูเทานั้น การมองจะอยูในลกัษณะมองจากดานบนลงมา
ดานลาง วิธีการเรียกใชงาน Layer คลิกที่เมนูคําสั่ง Window ที่แถบ Menu bar เลือกคําสั่ง Show Layer ถาหากพบวา 
Hide Layers แสดงวา Palette Layer ถูกแสดงแลว 
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Active Layer คือ Layer ที่กําลังถูกทํางานอยู สามารถเลอืก Layer ไดจากการคลิกที่แถบ Layer จากนั้นชอง 
Indicates if Layer is จะมีสัญลักษณรูปพูกันปรากฏ หากตองการเคลื่อนยาย Layer โดยให Layer อื่นเคลื่อนยายตาม
ใหคลิกที่ชอง Indicates if Layer is ใหเปนรปูโซเพื่อเชื่อม Layer เขาดวยกัน  

การเปลี่ยนลําดับของ Layer สามารถทําไดโดยคลิกเมาสที่ Layer คางไวแลวลากไปยังลําดับของ Layer ที่
ตองการแลวปลอยเมาส 

ที่ชอง Indicates Layer Visibility หากปรากฏสัญลักษณรูปตาหมายความวา Layer นัน้ถูกแสดงอยู หาก
ตองการซอน Layer ไมใหแสดงผล ใหคลกิที่ชอง Indicates Layer Visibility สัญลักษณรูปตาจะหายไป 

 

Active Layer 

Indicates Layer Visibility 

 
 
 
 
 
 
 

 
 
การสราง Layer 
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ขึ้นใหม ใหคลิกที่ปุม        หากตองการคัดลอก Layer ใหคลิก Layer ที่ตองการแลวปลอย
ลงที่ปุมนี้เชนเดียวกัน แตถาตองการลบ Layer หลังจากคลิกเลือก Layer ที่ตองการแลวใหคลิกที่ปุม  
 

การ Lock Layer 
 

เปนการกําหนดคุณสมบัติตาง ๆ เพื่อบังคับไมให Layer ถูกเปลี่ยนแปลงหรือไดรับผลกระทบใด ๆ มี
ทั้งหมด 4 รูปแบบดังนี ้

 
1. Lock transparent pixels หามไมใหเติมสีหรือปรับแกสีลงไปใน pixels ที่โปรงแสงบน Layer ได 
2. Lock image pixels หามไมใหมีการแกไขหรือตกแตงภาพบน Layer 
3. Lock position หามไมใหมกีารเคลื่อนยายตําแหนงของ Layer  
4. Lock all หามโดยใชการกําหนดคุณสมบัติของทั้ง 3 ขอที่กลาวมา 
 

1 2 3 4 
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การ Merge Layer  
 

เปนการรวมชัน้ของ Layer ต้ังแต 2 ชั้นขึ้นไปมาไวรวมกัน โดยคลิกที่ปุม     แลวจะปรากฏ Dialog 
สําหรับเลือกแบบตาง ๆ ของการ Merge Layer ดังนี ้

 
 
 
 
 
 
 
 
 
 

- Merge Down  Merge Linked  หรือ
เปนการรวม Layer ที่ใชงานอยูกับ Layer ที่อยูลําดับถัดลง โดยถา Layer ที่อยูลําดับถัดไปมีสัญลักษณ
รูปโซ จะมีขอความวา Merge Linked แตหากไมมีรูปโซจะมีขอความวา Merge Down 

- Merge Visible  
เปนการรวม Layer ที่ถูกแสดงหรอืมองเห็นไดทั้งหมด

- Flatten Image  
เปนการรวม Layer ทุกลําดับชั้นเปน Layer เดียว โดยมีชื่อวา Background และจะลบ Layer ที่ถูกซอน
ทิ้งไป 

 
หากตองการเปลี่ยนชื่อของ Layer ใหคลิกเลือก Layer Properties จะปรากฏ Dialog ของ Layer ซึ่ง

สามารถเปลี่ยนชื่อของ Layer ได และแถบสีได
 

 
 
การจัด Set ของ Layer 
 

 เปนการรวบรวม Layer ตาง ๆ มาไวเปนกลุม Layer Set สามารถใชคําสั่งตาง ๆ เหมือน Layer ทั่ว 
ไป เชน การดู คัดลอก เคลื่อนยาย และการเปลี่ยนลําดับ ยกเวนคําสั่งบางคําสั่ง เชน Layer Effect ดงันั้นใช
งานคําสั่งใด ๆ ของ Layer Set จะเกิดขึ้นกับ Layer ภายในทุก Layer 
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 การสราง Layer Set คลิกที่ปุม          เพือ่สราง Set หลังจากนั้นใหคลิกเลือก Layer ที่ตองการ
จัดเก็บคางไว แลวลากที่ Layer Set จากนั้นใหปลอยเมาส 

 
หากดับเบ้ิลคลิกที่ Layer Set จะปรากฏ Dialog ของ Layer Set Properties ซึ่งสามารถเปลี่ยนชื่อของ Layer  

                                                             Set ได และแถบสีได 
 
 
 
 
 
 
 
 

 

การทําภาพโดยใช Filter 
 

 ฟลเตอร (Filter) คือการตกแตงภาพดวยเทคนิคพิเศษ ที่สามารถปรับเปลี่ยนรูปแบบของภาพตามความ
ตองการของงาน เราสามารถใชงาน Filter ไดโดยเลือก Menu > Filter > เลือกใช Filter ที่ตองการ 

 

ตัวอยางการใช Filter 
ที่ Menu Bar จะมีปุม Filter(1) อยู เม่ือกดแลวจะมี Filter Menu ปรากฏขึ้นเลื่อนเมาสไปยัง Filter 

“Blur”(2) จะมีเมนูยอยเพิ่มขึน้มา ใหกดเลือกที่ “Redial Blur”(3) 
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เม่ือเลือกเสร็จแลวจะปรากฏหนาจอการปรบัเปลี่ยนลักษณะของ Filter สามารถที่จะกําหนดไดตามตองการ 
(ใน Filter แตละตัวนั้น หนาจอการปรับเปลี่ยนลักษณะของ Filter จะไมเหมือนกนั) เสร็จแลวกดปุม OK เพื่อจบขั้นตอน
การทํางานของ Filter 

 

 
 

จะไดภาพที่มีการตกแตงดวย Filter: Radial Blur ออกมา ทัง้นี้ ถาใช Filter อื่นรูปงานที่ปรากฏ จะตางกันออกไป 
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ตัวอยาง Filter ที่นาสนใจ  
 

 

 
ภาพตนแบบ 

 

 
Smudge Stick 

 

 
Gaussian Blur 

 

 
Radial Blur 

 

 
Angled Strokes 

 

 
Mosaic 

 

 
Facet 

 

 
Fragment 

 

 
Lens Flare 

 

 
Lighting Effects 

 

 
Sharpen 

 

 
Graphic Pen 

 

 
Halftone Pattern 

 

 
Stamp 

 

 
Water Paper 

 

 
Wind 
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การใชงาน Layer Style 
 

คลิกที่เมนู Layer > Layer Style > Blending Options จะปรากฏหนาตางดังภาพขางลาง 
 

 
 

(1) คือ Style ที่ตองการใชกับ Layer ที่เราเลือกไว จะมีใหเลือก 10 แบบจากบนลงลาง 
(2) คือ การกําหนดคาตางๆ ของแตละ Style ซึง่จะแตกตางกันไปในแตละ Style 

 
ตัวอยางการใช Layer Style 
 

 
Drop Shadow 

 
Inner Shadow 

 
Outer Glow 

 
Inner Glow 

 
Bevel and Emboss 

 
Satin 

 
Gradient Overlay 

 
Pattern Overlay 

 
Stroke 
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การเปลี่ยนรูปรางของรูป (Transform) 
 
เราสามารถเปลี่ยนแปลง Layer ในรูปแบบตางๆไดเชน การยอ/ขยาย การหมนุภาพ การบิดภาพ ดวยคําสั่ง 

Transform โดยคลิกเลือก Edit > Transform > (เลือก Transform Function ที่ตองการ) 
 

ลักษณะของ Transform 
 

 
ภาพตนแบบ 

 
Scale 

 
Rotate 

 
Skew 

 
Distort 

 
Perspective 

 
 

การปรับคาความสวาง/ความคมชัด (Brightness/Contrast) 
 
การปรับความสวาง-ความมืดของภาพ และการตัดกันของสีที่ชัดเจนขึ้นนัน้ สามารถทําไดโดยใชคําสั่ง 

Brightness/Contrast โดยเลือกคลิกที่ Image > Adjust > Brightness/Contrast 
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Original 

 
Brightness 

 
Contrast 

               
                    

การปรับขนาดของชิ้นงาน  
 

Image Size 
Image Size คือการ ลด/ ขยายรูปภาพโดยสามารถใชคําสั่งนี้ไดจากเมนู Image > Image Size… 

จะปรากฏหนาตางที่ใหเรากําหนดขนาดของภาพขึ้นมาดังรูป 
 

               
 

(1) Width(กวาง) และ Height(สูง) ของรูปภาพ สามารถกําหนดไดตามตองการ โดยมีหนวยให
เลือกสองแบบคือ Pixel และ % 

(2) Constrain Proportions Sign เม่ือสัญลักษณนี้ปรากฏดังรูป แสดงวาเมื่อเราไดกําหนดขนาด
ภาพไวดานใดดานหนึ่งแลว โปรแกรมจะกําหนดสัดสวนของดานที่เหลือใหเอง(อัตราสวนที่เทากัน) ผลที่ไดก็คือ 
ไมวาจะยอหรอืขยาย รูปภาพที่ออกมาก็จะมีอัตราสวนของ กวาง x สูงเทาเดิม 

(3) Constrain Proportions Check Box จาก (2) เม่ือเราไมตองการ ยอ/ขยาย รูปภาพให
เหมือนอัตราสวนเดิมใหคลิกที่ Check Box ออก เครือ่งหมาย  จะหายไปหลังจากนัน้การกําหนดขนาด กวาง
และสูงสามารถกําหนดไดตามตองการ 
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Canvas Size 
การ Canvas Size คือการลด/ ขยายพื้นทีรู่ป โดยเพิ่มพืน้ Background และสามารถขยายรูปโดย

กําหนดทิศทางได ดังรูป 
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ตัวอยางการ Canvas Size 

 

 
 

พื้นที่ที่เพิ่มจากการ 

Canvas 

1. Current Size ขนาดปจจุบันของงาน 

2. New Size ขนาดที่เพิ่มขึ้นจากขนาดของงาน 

3. Relative เปนคุณสมบัติบอกคาขนาดของ New Size 

เครื่องหมาย  คาในชอง Width และ Height จะเปน 0 

สามารถเพิ่มพื้นที่งานโดยไมตองรวมคา Current Size  

4. Anchor ที่ทางที่ตองการเพิ่มขนาดใหไปในทิศทางที่

ตองการ 

1 

2 

3 

4 
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การตัดกรอบของรูป (Crop) 
 
 การ Crop คือ การตัดกรอบภาพเอาเฉพาะที่ตองการ นอกจากรูปภาพจะมีขนาดเล็กเกินไปแลว บางครั้ง
รูปภาพก็มีขนาดใหญเกินไปไดเชนกัน เราสามารถตัดกรอบภาพ (Cropping) ใหเหลือเฉพาะที่ตองการไดโดยใช
เครื่องมอืสองชนิดนี้ ดังนี ้
 

วิธีที่ 1 การตัดกรอบภาพโดยเครื่องมือ Rectangular Marquee Tool 
1. เลือกเครื่องมือ                  บนแถบเครือ่งมือและกําหนด Feather ใหเทากับ 0 กอน 
2. สราง Selection ที่ภาพในสวนที่ตองการตัดกรอบ  
3. เลือกเมนู Image -> Crop จะไดรูปจากการ Cropping  

 
วิธีที่ 2 การตัดกรอบภาพโดยเครื่องมือ Crop 
1. เลือกเครื่องมือ                 บนแถบเครือ่งมือ 
2. สรางพื้นที่ที่ตองการตัดกรอบภาพ สังเกตวาจะเกิดแถบสีเทาขึ้นบริเวณรอบนอกขอบกรอบที่สรางขึน้มา 

บริเวณสีเทาคือ บริเวณของรปูภาพที่ถูกตัดทิ้งนั่นเอง 
3. ปรับแตงพืน้ทีท่ี่เลือก 
4. คลิกปุม            เพือ่ยืนยนัการตัดกรอบรปูตามตองการ (กรณียกเลิกใหคลิกปุม         แทน) 

 
ตัวอยางการ Cropping 
 

ภาพกอนการ Cropping 
 

ภาพหลังการ Cropping 
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